
RELEASE NOTES FOR NUKE 7.0v9

Release Date 19 September 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) or above

• Windows XP Professional x64 Edition or above

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, CUDA graphics drivers are bundled with the reg-
ular drivers for your NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features • BUG ID 36378 - MergeMat: A new also merge dropdown has been added 
to the properties panel allowing you to merge additional channel sets.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
Feature 
Enhancements

• BUG ID 34656 - DeepRead: You can now use custom file extensions for 
Deep .exr files in the same way as standard files.

For example, adding an odzReader.tcl file to your .nuke directory contain-
ing the lines:
load "exrReader.so"

add_file_extension_alias "odz" "exr"

Allows Nuke to read .odz files using the .exr reader.

Bug Fixes • BUG ID 14637 - Setting the Reformat node type to scale caused proxy to 
behave incorrectly.

• BUG ID 21327 - Mac OS X and Windows only: Dragging R3D files from 
the OS file browser set the wrong gamma space curve.

• BUG ID 21760 - RotoPaint: It was not possible to expression link the 
Transform tab center x and y values.

• BUG ID 26224 - The Ramp node’s Viewer handles did not update as 
expected.

• BUG ID 30535 - The right-click Edit > Generate function could not create 
more than 4002 keyframes for animated controls.

• BUG ID 33016 - Dope Sheet: Changing the Interpolation type for Roto 
spline keys had no effect.

• BUG ID 33916 - Reading a different Alembic file into a Camera already 
reading an Alembic file caused Nuke to crash.

• BUG ID 34543 - Tracker: Copying and pasting nodes containing 
expression links did not update the links to point to the new nodes.

• BUG ID 35201 - Nuke Assist: Pasting in a tree of nodes failed when the 
first unsupported node was reached.

• BUG ID 35203 - Nuke could not read a particular customer .hdr file.

• BUG ID 35244 - Lens Distortion: Adjusting Radial Distortion did not 
update the Card Parameters.

• BUG ID 35329 - RotoPaint: Certain properties panel controls returned to 
their default values when switching between paint tools.

• BUG ID 35461 - Nuke Assist: Buttons inside gizmos were disabled.

• BUG ID 35500 - It was not possible to enable interactive mode for lights 
if the Camera connected to the ScanlineRender node was reading from a 
file.

NOTE: This issue is still occuring on Linux builds. See Other Known Issues 
for more information.
Nuke 7.0v9The Foundry
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Bug Fixes 
• BUG ID 35989 - The output of a Merge node from inputs with identical 
bounding boxes increased the bounding box's size to 0 on the Y axis.

• BUG ID 36011 - RotoPaint: Merging empty RotoPaint nodes with other 
images, when the Merge node’s set bbox to control was set to union, 
extended the bounding box to the format’s origin (0,0).

• BUG ID 36039 - Particles: Changing the particle input from sprite to 
geometry, or vice versa, occasionally caused Nuke to crash.

• BUG ID 36209 - OCIO: The Viewer gain and gamma controls ignored the 
alpha channel when OCIO Viewer LUTs were used.

• BUG ID 36269 - Particles: Using emit from > in order with a high 
emission rate caused Nuke to crash.

• BUG ID 36278 - Project3D: Projecting onto the same geometry with 
PrmanRender and ScanlineRender did not produce similar results.

• BUG ID 36306 - Particles: ParticleEmitters with geometry connected to 
the particle input caused Nuke to crash if the orientation settings 
produced NaN (not a number) results.

• BUG ID 36337 - OCIO: Enabling Preferences > Viewer > use GPU for 
Viewer when possible and using OCIO Viewer LUTs caused the alpha 
channel to disappear.

• BUG ID 36461 - Attaching a HueCorrect node down-stream of an .exr 
containing NaN (not a number) pixels to a Viewer caused Nuke to crash.

• BUG ID 36810 - Linux and Windows only: The Viewer zoom shortcut 
Windows Key + middle mouse button did not work.

• BUG ID 37488 - Write: It was possible to select file type > abc in the 
standard Write node’s properties panel, even though Nuke cannot write 
Alembic files without using a WriteGeo node.
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
Known Issues 
and Workarounds

This section covers known issues and gives workarounds for them.

Known Issues 
Specific to Nuke 7.0

• BUG ID 38018 - Alembic: Reading in heavy .abc files can cause Nuke to 
crash.

• BUG ID 37854 - Windows only: Nuke does not currently support 
QuickTime files larger than 2 GB.

• BUG ID 37775 - Frames in a transcoded sequence containing transitions 
occasionally appear to be black, not faded-in/out or cross-dissolved as 
expected. This is due to an issue with Nuke 7.0v7, when rendering from 
the command line.

This rendering bug will be addressed in a future version of Nuke. In the 
meantime, if you are experiencing unexpected results with transcoded 
transitions from Hiero, you can do either of the following as a work-
around:

• Change the renderer path to Nuke 7.0v6:

In Preferences > Nuke/Export, point the Nuke Path to Nuke 7.0v6 and 
enable Use Specified Path for Hiero Renders.

• Render the .nk Script in the Nuke GUI:

Enable Keep Nuke Script on your export preset, locate the .nk script, 
open it in Nuke and render it out from the GUI.

• BUG ID 37416 - RotoPaint: Expression linking the rotate control to other 
nodes has no effect when the control is adjusted.

• BUG ID 37179 - RotoPaint: The Root layer is not transformed as 
expected when driven by expressions applied to the RotoPaint controls.

• BUG ID 37060 - Particles: Connections between the Particles > P_FogBox 
toolset and ParticleExpression nodes are not saved when scripts are 
saved and reloaded.

• BUG ID 37031 - Windows only: Adding a Tracker node directly after an 
OFlow node and then adding and adjusting a tracking anchor occasionally 
causes Nuke to crash.

• BUG ID 37018 - Some readers and writers, such as objreader and 
exrwriter, don’t accept certain characters (ÆØ or Å) in the filepath field.

• BUG ID 37011 - Mac OS X only: The QtUiTools library is missing from 
<install directory>/plugins/PySide.

• BUG ID 37684 - Dope Sheet: Deleting all keyframes from a roto shape 
resets all points to the format origin (0,0).

• BUG ID 36763 - Cloned Tracker nodes do not currently render from the 
command line.
Nuke 7.0v9The Foundry
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• BUG ID 36741 - RotoPaint: Setting the Project Settings > proxy mode 
control to format and dragging points within a selection moves the points 
at the wrong scale.

• BUG ID 36605 - RotoPaint: Adjusting the translate controls using 
expression links from a Transform node with split views occasionally 
applies unwanted offsets.

• BUG ID 36249 - Setting a color curve expression in the ColorLookup node 
to use x (return current frame) occasionally causes Nuke to crash.

• BUG ID 35976 - Some CUDA code runs in render mode, even when the  
--gpu argument is omitted.

You can disable all CUDA code by setting the FN_NUKE_DISABLE_CUDA 
environment variable to 1.

• BUG ID 35284 - Windows only: Exiting Nuke can be unacceptably slow, 
causing issues for render farms.

Set the environment variable NUKE_USE_FAST_ALLOCATOR to 1 to work-
around this issue.

• BUG ID 34357 - Adjusting translate or rotate values in Transform nodes 
upstream of Tracker nodes causes Nuke to become unresponsive.

• BUG ID 33254 - PlanarTracker’s Roto node defaults to the Select all tool 
rather than Bezier. If you click on the Viewer, then change the tool and 
draw a shape, your shape is added to the root layer instead of 
PlanarTrackerLayer1. This means it’s not considered for tracking, and 
tracking fails.

The workaround is to:

• make sure PlanarTrackerLayer1 is selected in the Roto properties,

• change to one of the shape tools before attempting to draw in Viewer, 
and

• in the Roto properties, make sure a purple rectangle appears in the PT 
column to indicate that the shape is considered for tracking.

• BUG ID 33053 - ModelBuilder: Using the Face Selection tool in the 3D 
Viewer disables the Scale handles (Ctrl/Cmd+Shift).

As a workaround, press F to fit the contents to the Viewer and then move 
the Viewer to a different angle before activating the Scale handles.

As a workaround, click Start in PLE to run Nuke Assist as normal.

• BUG ID 32856 - PositionToPoints: Textures occasionally disappear 
during playback or when mousing over the Viewer.

• BUG ID 32832 - ParticleEmitter: Emitting from faces with emit order set 
to uniformly or in order causes color from texture to be ignored.

• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

• BUG ID 32628 - DeepToPoints: Command line rendering appears to 
calculate renders even when render is set to off.
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely 
consistent with REDCINE-X and Hiero.

• BUG ID 32472 - RotoPaint: Undoing transforms of shapes with modified 
points causes RotoPaint to become unresponsive.

To work around this issue, deselect the shape by clicking away from it 
and then reselect it.

• BUG ID 32459 - RotoPaint: Undoing a point move that created a 
keyframe doesn't currently undo the keyframe creation.

• BUG ID 32457 - RotoPaint: In multi-view scripts, it is not currently 
possible to cut and paste a split shape.

• BUG ID 32353/32359 - Right-clicking on a point in the Viewer doesn’t 
always update the available Link to > Tracker linking dialog or Tracker 
options.

As a workaround, close and re-open the Roto/RotoPaint Properties panel 
to update the Link to menu.

• BUG ID 32340 - SplineWarp: Ctrl/Cmd drag-creating rectangles and 
ellipses doesn't display an overlay until pen-up.

• BUG ID 32219 - DepthToPosition: Reading depth information from the 
same layer as the output layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.

• BUG ID 32118 - Card3D: When motionblur is enabled in the properties 
panel, FrameHold and TimeOffset nodes are ignored when connected to 
the cam or axis inputs.

• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets 
its correspondence points to 0,0, which cannot be undone.

• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive to 
when control points are removed.

• BUG ID 31431 - Linux only: The current version of the FFmpeg library 
used by Nuke reads the height of HD .mov files at 1088, rather than 
1080.

As a workaround, use a Reformat node to force the input to the correct 
format.

• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect 
cameras, lights, or axes.

• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash 
value, it’s unique identifier, causes the cache to release. Actions such as 
adjusting the Viewer Gamma, Gain, or channels dropdown affect the 
frame hash.

• BUG ID 30903 - Windows only: Some scripts render significantly slower 
on Windows than on Linux.

Set the environment variable NUKE_USE_FAST_ALLOCATOR to 1 to work-
around this issue.
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
• BUG ID 30502 - Copying and pasting spline keys does not work as 
expected in the Dope Sheet.

• BUG ID 30429 - SplineWarp: Transform links are not maintained when 
the source curve is moved to a new layer.

• BUG ID 30256 - Script Editor: Flagging a control as invisible using 
setFlag() is not honored when the node is copy/pasted in the Node Graph.

• BUG ID 30116 - Tracker: Adding tracking anchors with an OFlow node 
upstream of the Tracker causes Nuke to become unresponsive.

• BUG ID 29677 - Connecting a FrameHold node to an animated Camera 
and connecting both to a Scene node only displays the animated Camera 
in the Viewer. There should be two cameras: one static and one animated.

• BUG ID 29382 - Tracker: Tracking keyframes with different sized 
patterns doesn’t work as expected. 

As a workaround, keyframe patterns should, where possible, be of com-
parable sizes.

• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position 
and rotation. The focal length of the new camera does not match that of 
the Viewer camera.

• BUG ID 28838 - Gizmos containing Roto/RotoPaint nodes should be 
recreated in Nuke 7, but bear in mind that they won’t be backwards 
compatible with Nuke 6 once converted, unless you follow the 
instructions below:

Nuke 6 scripts containing Roto display a conversion prompt when you 
open them in Nuke 7:

• Click Save As to convert the script to the Nuke 7 Roto format, or

• Click Ignore to load the Nuke 6 format into Nuke 7. You might select 
this option if:

• You don't intend to make any changes, or

• You want to overwrite the file with a Nuke 7 only Roto format 
when saving.

If you want Nuke 7 scripts to load in Nuke 6, use the convertToNuke6 or 
convertDirectoryToNuke6 Python functions when running Nuke 7 in ter-
minal only mode:

NOTE: This known issue only applies to Roto and SplineWarp keys.

NOTE: The conversion functions cannot convert stereo-split curves as 
they are not supported by Nuke 6.
Nuke 7.0v9The Foundry
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• To convert individual .nk scripts:

• convertToNuke6(fromScript, toScript, overwrite = False)

• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern 
=".*\.nk", overwrite = False)

An example single script conversion and rename to the same directory, 
from the command line (terminal):

$ <NukeInstallDir>/Nuke7.0v1 -t

>>> import nuke.rotopaint
>>> nuke.rotopaint.convertToNuke6("/tmp/myRoto7.nk", "/
tmp/myRoto6.nk")

• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is 
not always honored for .abc files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.

• BUG ID 26855 - Roto/RotoPaint/SplineWarp: The undo and redo buttons 
in the properties panel didn’t work as expected and have been disabled. 

The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) 
hotkeys instead.

As a workaround, use the Edit menu or Ctrl/Cmd+Z instead.

• BUG ID 19542 - Particles: Previously, ParticleEmitters checked if a given 
particle collided on the next frame, and if so, spawn at the current 
position (i.e. above the plane). In Nuke 7.0, the spawn only occurs at the 
actual collision point (i.e. on the plane).

• BUG ID 14460 - Roto: Unfurling the format and mask controls in the 
Properties panel can cause controls to be hidden by the curves list.

As a workaround, resize the Properties panel to reveal the controls.

• Plug-ins installed using the Nuke Plug-in Installer may not work correctly 
as they were complied against an earlier version of Nuke.

Other Known Issues AudioRead

• BUG ID 18924 - Changes to the rate control value are not honored when 
ratesource is toggled between file and custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a 
Flipbook.

NOTE: The pattern is a regular expression.
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
• BUG ID 18465 - The time range control doesn’t limit the range when an 
endtime is specified.

• BUG ID 18451 - Flipbooking doesn't honor the time range knob.

• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet 
doesn't redraw the curves correctly.

FrameCycler

• BUG ID 17199 - There aren't appropriate LUTs in 6.2v3 for flipbooking 
some colorspaces including rec709, Gamma 1.8, Gamma 2.2, Panalog, 
REDLog, ViperLog and REDSpace. As a workaround, you need to select 
Burn in the LUT in FrameCycler for an authentic color reproduction.

• BUG ID 15204 - There are currently some graphical glitches occurring 
when flipbooking certain images. The workaround is to change the cache 
precision in FrameCycler. To do this, bring up the settings menu in 
FrameCycler (press S), go to Options > Cache and change the Cache 
precision option to either 16 bit float or 8 bit int + 16 bit float. 

• BUG ID 15046 - Flipbooking to FrameCycler with images greater than 4K 
in width, and with a non-1 pixel aspect ratio, skews the images (in 
FrameCycler). This is an issue with FrameCycler 2009, and we are 
awaiting a fix.

• We direct FrameCycler to write to the user’s Nuke temp directory 
(NUKE_TEMP_DIR) for its user settings files. You can redirect this by 
modifying the FrameCycler/settings/Global_Settings.xml file that can be 
found within your Nuke installation.

• Flipbooking with FrameCycler 2009 may not work on some older Intel and 
AMD processors with certain graphics card configurations. You can set 
the FC_PATH environment variable to point to a previous version of 
FrameCycler (that is FrameCycler 2008 found in Nuke 6.0v7). For 
information on setting environment variables, please refer to the 
Configuring Nuke chapter in the Nuke User Guide.

For example, you can point FC_PATH to the following locations (check the 
correct path to the installation on your machine):

• Mac:

/Applications/Nuke6.0v7-32/Nuke6.0v7.app/Contents/MacOS/Frame-
CyclerOSX/bin/FrameCycler

• Windows:

Program Files\Nuke6.0v7\FrameCycler\Windows\bin\FrameCycler.exe
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
• Linux:

/usr/local/Nuke6.0v7-32/FrameCyclerCentOS4.4/bin/framecycler

Linux Version

• BUG ID 21327 - Linux only: Dragging R3D files from the OS file browser 
sets the wrong gamma space curve.

Mac OS X Version

• BUG ID 22062 - Nuke doesn't currently give the option to restore the 
autosave of an unsaved script, except when Nuke is run from the 
command line.

• BUG ID 13638 - The following graphics cards are not currently supported 
for Mac:

• ATI Radeon X1600

• ATI Radeon X1900

Users with these cards will be able to render from the command line, but 
in GUI sessions, the Node Graph will render incorrectly due to a require-
ment of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there 
is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain 
zoom levels.

Particles

• BUG ID 18268 - Enabling color from texture always renders a solid white 
alpha for the texture.

• BUG ID 17520 - Geometry representation textures are displayed even 
when display is set to off.

• BUG ID 17243 - Using sprites instead of geometry representations 
causes particles to render behind the 3D grid lines.

PlanarTracker

• BUG ID 19683 - After adjusting the planar surface using the Correct 
Plane Viewer button, you have to undo twice for the planar surface to 
return to its original position.

• BUG ID 19563 - PlanarTracker: Detected or tracked features are not 
offset by the origin of the input image's bounding box. 

Please contact support@thefoundry.co.uk if you need older versions of 
The Foundry software.
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
To avoid this, you can add a Crop node before PlanarTracker’s associated 
Roto node.

• BUG ID 19240 - When Viewer downrez is greater than 1, the 
clearTrackDataForward button currently offsets bezier shapes to fit the 
root format.

To return the shape to its original size and position, advance the 
sequence one frame.

PrmanRender

• BUG ID BUG ID 27648 - After a security update for Mac OS X, Nuke is 
unable to load the PrmanRender plug-in when in GUI mode.

See http://support.apple.com/kb/HT5281 for more information.

As a workaround, set the following environment variables:
export RMANTREE=/Applications/Pixar/RenderMan.app/

Versions/RenderManProServer-15.1
export DYLD_LIBRARY_PATH=$RMANTREE/lib

Then launch Nuke from the command line.

Python

• BUG ID 36594 - Viewer Processes cannot be unregistered using the 
init.py or menu.py files.

• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the 
in-panel argument at default (True) may crash when too many node 
control panels are created too quickly. The workaround is to pass the in-
panel argument as False or else use nuke.nodes.NodeClass() (where 
NodeClass is the type of node to create) to create the node and then 
connect it to the currently selected node manually.

• BUG ID 6455 - You should not call the Python command 
nuke.restoreWindowLayout() from the Script Editor as that can cause 
Nuke to crash. Instead, you can use the same command from your 
menu.py, restore layouts by selecting Layout > Restore Layout, or use 
a custom menu or toolbar item.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar 
to the following: 

groupName.NodeName.knobname: unexpected 'k' in '0.knobname' 

The problem is most likely that there is an expression that is using the 
input TCL command and doesn't validate that there is an input connected. 
An example expression: 

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, 
which generates an expression of '0.knobname' that doesn't refer to any-
thing. The fix is to restructure the expression to use the value TCL com-
Nuke 7.0v9The Foundry
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Known Issues and Workarounds 
mand and specify a default value to return in the case that the expression 
is invalid. It takes the form: 

[value [input parent inputnumber].knob defaultValue] 

Here is the modified example: 

[value [input parent 0].translate.x 0]

The modified example will return 0 in the event that there is no input 0, 
and no longer result in an error message.

• There is a Python syntax conflict when assigning knob names on the fly 
with nuke.nodes.<node>() if the knob is called 'in'.

For example, this will give a syntax error:

nuke.nodes.Shuffle(in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')

QuickTime ProRes 4444

• BUG ID 17360 - Some customers have experienced unexpected shifts in 
chroma values when using the ProRes 4444 .mov codec.

A possible workaround is to modify the GlobalSettings.csv found in the 
following locations:

Mac OS X

/Applications/Nuke7.0v6/Nuke7.0v6.app/Contents/Resources/

Windows

 C:\Program Files\Nuke7.0v6\

Add the following lines to the bottom of the .csv file:
# Apple ProRes 4444
encode,ap4h,appl,any,any,512
decode,ap4h,appl,any,any,512

Render Codecs

There have been issues where rendering with certain codecs makes Nuke 
crash. Due to this, we recommend the following:

• If you're using the Sorensen Video codec, it's recommended you use the 
Sorensen Video 3 codec instead. If you're unable to switch to Sorensen 
Video 3, try using a format smaller than 2K for better performance.

NOTE: Please be aware that this workaround is not reliable in every case.
Nuke 7.0v9The Foundry
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• If you're experiencing crashes with Cineform HD, try updating your 
Cineform codec to version 5 or above. You may need to download the 
Neoplayer at http://estore.cineform.com/neoplayer.aspx.

• If you're using Avid Meridien, you should only write out in NTSC and PAL.

RotoPaint

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t 
extend to the current frame, disappear when drag-selected.

As a workaround, select the shape in the curves list to re-display the 
points.

• BUG ID 30920 - Expression linking extra matrices in the Transform tab 
doesn’t work as expected.

• BUG ID 30551 - Several levels of smoothing applied to one shape are 
carried over to subsequent shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work 
for entries in the curves list.

• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there 
is another RotoPaint after it.

• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint 
cursor is near the edges of the screen.

• The foreground onion skin overlay updates as you paint. This will change 
so the overlay only updates with the new stroke on pen up. 

• It is not currently possible to clone RotoPaint nodes.

• Interactivity of laying down strokes/shapes in the Viewer may be faster 
when motion blur is disabled on the layer you are working in.

Warpers

• BUG ID 32079 - SplineWarp: Moving correspondence points on curves 
with no keyframes cannot currently be undone.

• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream 
transforms correctly.

• BUG ID 20000 - GridWarp: When using cropped input, moving control 
points causes the Viewer to display the cropped image and the black area 
between the crop box and the format when merged over a background.

• BUG ID 19995 - GridWarp: Locked source and destination grids still allow 
adding and removing grid lines.

NOTE: This also applies to SplineWarp matrices.
Nuke 7.0v9The Foundry
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• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in 
morph mode, when mix is set at an intermediate value.

• BUG ID 19755 - SplineWarp: Placing correspondence points at each end 
of an open spline causes rendering problems.

• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix 
amount when in morph mode with mix set at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope 
Sheet after undoing, rather than just the latest, and the keyframes remain 
on the Timeline and in the Properties pane.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a 
single point.

• BUG ID 19079 - SplineWarp: The C hotkey does not currently select the 
Add Correspondence Point tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and 
destination keyframes, even if a grid is not visible in the Viewer.

• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids 
selected, but in different positions, does not undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add 
keys to the Curve Editor or Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not 
cleared when you draw a new grid using the Draw Boundary Viewer 
button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve 
Editor using Ctrl/Cmd+A shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and grey 
when zooming in and out of the Viewer, particularly when the grid is 
subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labelled as 
default when you split controls into separate views.

Miscellaneous Known Issues

• BUG ID 32569 - Mac only: Textured objects occasionally disappear 
during playback when using DisplaceGeo and PositionToPoints nodes.

• BUG ID 31803 - Using Shift+drag on a control’s animation icon only 
copies the value for the current frame, not the entire expression.

• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox 
does not display individual bounding boxes for polymesh primitives.

• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

• BUG ID 29048 - OCIO: Using the ocionuke library in terminal mode 
results in an error.
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Known Issues and Workarounds 
• BUG ID 28921 - Windows only: Changing the 3D selection mode does not 
update until you click in the Viewer.

• BUG ID 28291 - Nuke crashes on startup if the disk cache location set in 
the Preferences is no longer available.

• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and 
choosing not to add new views to the project, subsequent reads of any 
stereo/multiview .exr files won’t give the option to add new views.

• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the 
Viewer with the control panel open.

• BUG ID 20204 - Multitexturing: When Preferences > Viewers > 
Multiframe is enabled, increasing downrez in the Viewer toolbar can 
cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to work-
around this issue.

• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a 
solid until you click in the Viewer.

• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally 
causes a slight graphical glitch in the Properties pane.

• BUG ID 18649 - The transform jack is currently scaling incorrectly from 
the corner pivot point.

• BUG ID 12505 - Motion Vector output has been improved, but still 
doesn't work properly because some large polygons are clipped by the 
front camera plane. 

You can minimize this effect by increasing the geometry tessellation max 
parameter.

• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or 
reverting when panning or zooming.

• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 
3D geometry selection and points drawn with RotoPaint. This only occurs 
if you have two Viewers open, one in 2D mode and the other in 3D mode, 
and you have the panel for the RotoPaint visible. 

• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate 
sequences in float. The limit per frame is 50MB. If your frames are larger 
than this, you may need to switch to proxy mode for the caching to work.

• BUG ID 5922 - At the moment, cloning does not work properly with all 
OFX nodes. This affects, but is not restricted to, any nodes that have an 
analysis pass.

• BUG ID 5690 - Windows run-time libraries are not packaged properly 
with Nuke.

Nuke runs correctly from a network install on Windows without specifi-
cally installing the run-time libraries, though we still recommend that you 
do so as there will still be some minor problems without them. For details, 
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Known Issues and Workarounds 
please see Installation on Windows in the Installation and Licensing chap-
ter of the Nuke User Guide.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which 
view you want to render. This question is unnecessary as the result is an 
anaglyph image. Irrespective of what view you choose, the flipbook 
output is the same.

• File types in Windows and Mac OS X are associated with the standard 
version of Nuke by default, so if you save a script on NukeX using 
features that are only included in NukeX (such as CameraTracker or 
FurnaceCore) and then double-click on the script icon to open it, it will 
open in standard Nuke instead of NukeX. 

• If you have trouble with FBX files, it may be because they were written 
with an older version of FBX. If they load very slowly, it is also possible 
that they are ASCII rather than binary. To get around these problems, you 
can use the FBX converter on the Autodesk web site. It converts between 
various different formats, including older FBX versions, ASCII, and binary, 
and is available on Windows, Mac OS X, and Linux.

To download the FBX converter:

1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?sit-
eID=123112&id=10775855 (or click here)

2. Scroll down to FBX Converter and click on one of the links to start the 
download.

• CameraTracker: Canceling lens distortion initialization results in corrupt 
tracks.

• 3D Camera: If you want to navigate through the 3D point cloud created 
by the CameraTracker node when using Create Scene:

• Select the Camera that was created in the 3D view when using the Cre-
ate Scene button.

• Press F to focus on the selected Camera. You can now navigate around 
the cloud. Do not try to focus (using F) on the point cloud. The result-
ing tumble camera movement is likely to be jumpy.

• PrmanRender: In the Nuke camera, the window roll control is not yet 
mapped to RenderMan.
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Developer Notes 
Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 28490 - Importing gizmos when addOnCreate() was set displayed 
a Foundry license de-coupled error.

• BUG ID 33005 - Evaluating node.knobs() in a Python OnCreate callback in 
a Transform node disabled the numeric pad nudge functions.

• BUG ID 34857 - The nuke.Undo().cancel() method did not work as 
expected.

NOTE: See Help > Documentation from the Nuke menu bar for more 
information.
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Release Date 11 June 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) or above

• Windows XP Professional x64 Edition or above

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, CUDA graphics drivers are bundled with the reg-
ular drivers for your NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features There are no new features in this release.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 36190 - Tracker: Expanding tracking anchor search areas caused 
Nuke to crash.

Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes There are no bug fixes in this release.

NOTE: See Help > Documentation from the Nuke menu bar for more 
information.
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Release Date 5 June 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) or above

• Windows XP Professional x64 Edition or above

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, CUDA graphics drivers are bundled with the reg-
ular drivers for your NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features There are no new features in this release.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.com/drivers
http://www.nvidia.co.uk/object/cuda_gpus_uk.html
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Feature Enhancements 
Feature 
Enhancements

• BUG ID 35259 - A Modo equivalent 3D control type has been added to  
Preferences > Viewers > Interaction.

• BUG ID 35548 - The examples in the documentation for the command line 
rendering -F frame range argument have been improved.

• BUG ID 35658 - Alembic: Load times and playback speeds have been 
improved for .abc files, particularly where the geometry is transform 
animated.

Bug Fixes • BUG ID 16894 - Windows only: Enabling PrmanRender > RIB > filter did 
not work as expected.

• BUG ID 17104 - Particles: Attaching a Constant to the ParticleEmitter 
particle input did not display color in the 3D Viewer.

• BUG ID 21535 - Windows only: Playback did not reach 24 fps when 
downrez was set to 32.

• BUG ID 23236 - The Ramp node's Viewer handles did not pivot until 
mouse up.

• BUG ID 25365 - Playback speed did not reach the full framerate when 
Viewer Stereo Modes was set to anything other than Single.

• BUG ID 31965 - Windows XP only: Rendering ZDefocus or Convolve 
nodes on the CPU caused Nuke to crash.

• BUG ID 32791/32794 - ParticleEmitter: Disconnecting a particle input 
when an emitter was connected to a Viewer caused Nuke to crash.

• BUG ID 33018 - ReConverge: The use Ocula if available check box has 
been removed. ReConverge no longer uses Ocula, even when available.

• BUG ID 33340 - ModelBuilder: Pressing Enter while adding geometry 
caused Nuke to crash.

• BUG ID 35024 - Hiero<>Nuke: Transcode scripts created in Hiero 
displayed the message Reader did not set bounding box when imported 
into Nuke.

• BUG ID 35197 - Windows only: Using Ctrl+C in Nuke when Hiero was 
open caused Nuke to become unresponsive.

• BUG ID 35297 - When the FN_NUKE_DISABLE_TMPLIC_NOTIFY_DIALOG 
environment variable was set, Nuke 7.0v6 launched straight into PLE 
mode if no license was available.

• BUG ID 35388 - OCIO Colorspace and OCIO Display used the knob index 
rather than the names of knob values, causing the wrong LUT to be used 
if the OCIO config file was changed manually.

• BUG ID 35496 - A Viewer was removed from a customer script due to an 
invalid viewerProcess.
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Bug Fixes 
• BUG ID 35552 - Some cross-referenced pages in the Getting Started 
Guide were incorrect.

• BUG ID 35554 - Copying .mov Read nodes using Ctrl+C during thumbnail 
rendering caused Nuke to crash.

• BUG ID 35581 - Disabling Preferences > Viewers > use GPU for Viewer 
when possible slowed the playback rate of Stereo Interlaced footage in 
the Viewer.

Bugs Fixes Omitted 
from Previous 
Release Notes

The following bugs were incorrectly omitted from previous Release Notes.

• BUG ID 22921 - Certain scripts contained inconsistencies in rendered 
output between ScanlineRender and PrmanRender.

• BUG ID 28094 - Alembic: Writing point clouds to .abc files did not write 
the point size correctly.

• BUG ID 32250 - RotoPaint: The color palette was hidden after each paint 
stroke in the Viewer.

• BUG ID 32506 - Windows only: Duplicating a tracker and expression 
linked transform linked to the inverse of the source tracker.

• BUG ID 32787 - Geometry with a midrange polygon count, followed by a 
Normals node, caused Nuke to crash if the attrib name field was changed 
to Cf or Vel.
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Developer Notes 
Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 23431 - Calling changed() on a RotoKnob cleared the selection 
highlight.

• BUG ID 35487 - Calling Link_Knob.getLinkedKnob() caused Nuke to crash 
when linked to disable knobs.

NOTE: See Help > Documentation from the Nuke menu bar for more 
information.
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Release Date 8 April 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) or above

• Windows XP Professional x64 Edition or above

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, CUDA graphics drivers are bundled with the reg-
ular drivers for your NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features Nuke 7.0v6 includes a new feature, Nuke Assist. Licensed as part of a 
NukeX maintenance package, Nuke Assist is intended for use as a 
workstation for artists performing painting, rotoscoping, and tracking. Two 
complimentary licenses are included with every NukeX license.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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New Features 
To launch Nuke Assist, do one of the following:

• Double-click the Nuke Assist icon on the Desktop.

• Double-click the Nuke Assist icon (or list item) from the install directory. 
For example, on Mac: /Applications/Nuke7.0v6/

• Using a command prompt, navigate to the Nuke application directory and 
enter:
./Nuke7.0v6 --nukeassist

You can load projects created in Nuke and NukeX and work as normal, 
within the constraints of Nuke Assist. The Viewer renders the output of the 
node tree whether the components are supported or not. Any unsupported 
nodes and plug-ins in the Node Graph are outlined in red and their controls 
are grayed out. The following nodes are supported by Nuke Assist:

NOTE: On Mac OS X, you shouldn’t move the Nuke Assist bundle from its 
original installation folder, as this prevents it from working correctly.

Image

Checkerboard ColorBars ColorWheel Constant

Read Viewer

Draw

Radial Ramp Rectangle Roto

RotoPaint

Time

FrameBlend FrameHold FrameRange TimeEcho

TimeOffset

Channel

Add Copy ChannelMerge Remove

Shuffle ShuffleCopy

Color

Invert OCIO CDLTransform OCIO Colorspace OCIO Display

OCIO FileTransform OCIO LogConvert

Keyer

Keyer

Merge

AddMix Dissolve KeyMix Merge

Premult Switch Unpremult
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Feature Enhancements 
As well as limiting the nodes available, Nuke Assist does not support:

• Rendering output using Write nodes.

• Editing unsupported node or plug-in controls, including those within 
gizmos, groups, and precomps.

• Adding unsupported nodes or plug-ins using Python.

Feature 
Enhancements

• Nuke now reads R3D file metadata and converts the gamma space setting 
to Linear automatically.

Click Load Settings in the properties panel to apply the gamma space 
specified in the file.

• Nuke’s performance when handling Alembic (.abc) files has been improved.

• BUG ID 8253 - Nuke now supports ARRIRAW files, which use the .ari file 
extension. Nuke uses the same ARRIRAW SDK version as Hiero to 
maintain consistency.

• BUG ID 34828 - CameraTracker: The Create Points button has been 
reverted to the Nuke 6.3 name, Create Scene, and now creates a Camera, 
PointCloud, and Scene with a single click.

• BUG ID 32554 - R3D file reader: Re-ordered the gamma and colorspace 
menu options to make them easier to find.

Transform

Crop CornerPin PlanarTracker Reformat

Tracker Transform TransformMasked

Views

JoinViews OneView ShuffleView Split and Join

Stereo Anaglyph Stereo MixViews Stereo ReConverge Stereo SideBySide

Metadata

AddTimeCode CompareMetadata CopyMetadata ModifyMetadata

ViewMetadata

Other

Backdrop Dot Group Input

Output PostageStamp StickyNote

NOTE: Bug 8253 was incorrectly omitted from the 7.0v1 Release Notes.
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Bug Fixes 
Bug Fixes • BUG ID 10028 - Deleting and undoing cloned nodes caused corruption in 
saved scripts.

• BUG ID 19788 - Windows only: Writing frames occasionally displayed a 
Can't rename .tmp to final, Permission denied error.

• BUG ID 24413 - Nuke crashed when opening a script that had an 
undefined knob in a Write node.

• BUG ID 24785 - OCIOLookTransform was missing from the Other > All 
plugins menu. 

You can also access OCIOLookTransform by pressing X on the Node 
Graph, making sure TCL is selected in the dialog that opens, typing OCIO-
LookTransform, and clicking OK.

• BUG ID 29966 - RotoPaint: There was no visual representation at the 
playhead of keyframes set on the stereo offset control.

• BUG ID 30008 - Alembic: Particle lifetime settings were not respected 
when a particle system was written to the .abc format.

• BUG ID 30791 - Light nodes did not display an error when an Alembic file 
was specified in the File control.

• BUG ID 32891 - SplineWarp: The second correspondence point added 
between curves was always placed incorrectly.

• BUG ID 33922 - Linux only: Manually unzipping the installer file created a 
Documentation/Python directory with restrictive permissions.

This directory now has drwxr-xr-x permissions.

• BUG ID 34363 - DeepToPoints didn’t handle bounding boxes correctly.

• BUG ID 34385 - When rendering particles to Alembic (.abc) files, particle 
colors were only written on the first frame because Alembic doesn’t 
support time-sampled colors. This sometimes gave particles the wrong 
color.

Nuke now finds the frame with the most particles and writes the colors 
from that frame instead.

• BUG ID 34436 - Nuke’s exit codes have now been documented in the end 
of the Previews and Rendering chapter of the Nuke User Guide. You can 
also find them here:

0 = success

1 = render error

100 = license failure

• BUG ID 34734 - The Precomp node’s label was missing, causing the node 
to be called 1 instead of Precomp1.

• BUG ID 34878 - CameraTracker: No warning was displayed when 
attempting to track and solve from a single frame.

• BUG ID 35009 - Nuke crashed when opening the Roto properties panel in 
a customer script that included a disabled SplineWarp node.
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Developer Notes 
Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 33060 - Alembic: The setImportedItems() method did not retain 
the current selection when new items were imported.

NOTE: See Help > Documentation from the Nuke menu bar for more 
information.
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Release Date 07 March 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) and 10.7 “Lion” (64-bit)

• Windows XP Professional x64 Edition or Windows 7 Home Premium x64

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, CUDA graphics drivers are bundled with the reg-
ular drivers for your NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features There are no new features in this release. For a list of features new to  
Nuke 7, see Release Notes for Nuke 7.0v1.

NOTE: Mac OS X 10.8 “Mountain Lion” and Windows 8 are currently not 
supported as operating systems for Nuke.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
Feature 
Enhancements

• The DPX reader now supports infra red (IR) passes produced using 
FilmLight’s Northlight film scanner.

Bug Fixes • BUG ID 21971 - Processing a Convolve node took longer when channels 
was set to all rather than rgba, even if there were no other channels in 
the input.

• BUG ID 23025 - Certain customer scripts that included RotoPaint were 
slower in Nuke 6.3 than 6.2.

• BUG ID 25066 - Using a Switch node with F_Kronos while scrubbing the 
timeline caused a segmentation fault.

• BUG ID 25446 - Roto: When motionblur was enabled, setting opacity to 1 
didn’t always produce a fully opaque shape.

• BUG ID 25907 - The output control on Roto nodes did not default to 
alpha. RotoPaint nodes remain unchanged, defaulting to rgba. 

• BUG ID 26508 - PointCloudGenerator: Right-clicking in the groups list on 
the Groups tab produced unnecessary animation menu items.

• BUG ID 31205 - LensDistortion: The results produced by Analyze 
Sequence differed slightly between Nuke 6.3v8 and Nuke 7, due to 
LensDistortion being updated to use the same tracking as CameraTracker 
and PlanarTracker.

• BUG ID 33710 - ZDefocus didn’t always work if use input channels was 
checked.

• BUG ID 33820 - When using a customer Python script, Nuke 7.0 returned 
an additional error in the error console, causing issues with command line 
renders when error trapping.

• BUG ID 33968 - Using several Kronos and Denoise nodes caused Nuke to 
spawn a large very number of threads, which sometimes resulted in a 
crash.

• BUG ID 34027 - Roto shapes imported into Nuke 7.0 from other 
applications were offset after the Nuke script was saved and reopened.

• BUG ID 34176 - LensDistortion: When drawing a line with Drawing Mode 
On enabled, points were offset from the cursor.

• BUG ID 34206 - RotoPaint: Modifying keys in the Dope Sheet 
disconnected some keys from their curves in the Curve Editor.

• BUG ID 34217 - RotoPaint: B-spline point positions sometimes got reset 
to 0,0 after undoing an action.

NOTE: Bugs 23025, 25066, 25446, and 25907 above were incorrectly 
omitted from the 7.0v1 Release Notes.
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Developer Notes 
• BUG ID 34286 - Roto: Moving keys in the Curve Editor and then undoing 
an action added more keys.

Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 32266 - The SceneView knob shouldn’t have required certain 
flags to be set for imported and selected items to be saved.

• BUG ID 33675 - Rendering a customer script with low available cache 
memory caused Nuke to crash, when MemoryHolders were unregistered 
after they had become invalid.

NOTE: See Help > Documentation from the Nuke menu bar for more 
information.

NOTE: Any code that uses MemoryHolders should call the 
unregisterMemory() function.

Do not call registerMemory() or unregisterMemory() from intermediate 
class constructors or destructors—registerMemory() and 
unregisterMemory() must be called from the most derived class.

Alternatively, registerMemory() may be called after construction and 
unregisterMemory() may be called before destruction.
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Release Date  22 January 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) and 10.7 “Lion” (64-bit)

• Windows XP Professional x64 Edition or Windows 7 Home Premium x64

• Linux RHEL 5.4 for Intel64 or AMD64

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, these are the normal graphics drivers for your 
NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features There are no new features in this release. For a list of features new to  
Nuke 7, see Release Notes for Nuke 7.0v1.

NOTE: Mac OS X 10.8 “Mountain Lion” and Windows 8 are currently not 
supported as operating systems for Nuke.

NOTE: The compute capability is a property of the GPU hardware and 
can't be altered by a software update.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
Feature 
Enhancements

• New icons have been added to the documentation for points of interest in 
the text, such as notes and tips.

• BUG ID 30602 - The Preferences > Suppress bad channels checkbox has 
been removed from the Preferences dialog. 

Nuke now automatically discards any channels that are not referenced in 
the script when it is saved.

Bug Fixes • BUG ID 33586 - Particles: ParticleEmitters with 2D sprites connected to 
the particle input did not render in the 2D Viewer.

• BUG ID 33615 - Linux only: On some systems, disabling use GPU if 
available in the ZDefocus and Convolve Properties panel caused Nuke to 
crash when a Viewer node was connected.

Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes There are no bug fixes in this release.

NOTE: This bug fix was incorrectly omitted from the 7.0v1 Release Notes.

NOTE: See Help > Documentation > C++ Plug-in Development > NDK 
Developers Guide > Appendix C from the Nuke menu bar for more 
information.
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Release Date  16 January 2013

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) and 10.7 “Lion” (64-bit)

• Windows XP Professional x64 Edition or Windows 7 Home Premium x64

• Linux RHEL 5.4 for Intel64 or AMD64

Note Mac OS X 10.8 “Mountain Lion” and Windows 8 are currently not supported 
as operating systems for Nuke.

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

Note The compute capability is a property of the GPU hardware and can't be 
altered by a software update.

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, these are the normal graphics drivers for your 
NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features • BUG ID 32355 - Nuke has been updated to use OCIO version 1.0.7.

• For a list of features new to Nuke 7, see Release Notes for Nuke 7.0v1.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
• BUG ID 33101 - A new environment variable has been added to disable 
the license expiration dialog. To enable the new variable set 
FN_NUKE_DISABLE_TMPLIC_NOTIFY_DIALOG to 1.

However, you still get a warning if no license is found, for example if you 
only have a Nuke license but you try to run NukeX.

Feature 
Enhancements

• BUG ID 30576 - A new dropdown has been added to the Licensing dialog 
allowing you to use either FLEXlm or RLM license servers.

• BUG ID 32240 - ModelBuilder: The Bake scene selection button has been 
split into a Selected geometry dropdown and Bake button.

Bug Fixes • BUG ID 11951 - It was not clear in the documentation that the 
$NUKE_PATH environment variable is processed in reverse order when 
loading Python scripts.

• BUG ID 21068 - RotoPaint: Creating a RotoPaint node after loading a 
customer plug-in at startup then saving the layout and restarting, caused 
Nuke to crash.

• BUG ID 21212/23709 - Windows only: QuickTime filepaths containing 
expressions or relative paths (such as ../myClip.mov) caused Nuke to 
become unresponsive.

• BUG ID 28094 - Alembic: The PointCloudGenerator > Point Size control 
was not written to .abc files correctly.

• BUG ID 29341 - ModelBuilder: Pressing Enter when adding a shape 
canceled the action.

• BUG ID 29997 - The tooltips on some of the Light node’s controls were 
incorrect.

• BUG ID 30334 - When exporting some QuickTime files, a frame from the 
sequence was occasionally held for two frames.

• BUG ID 31455 - Updating to RenderMan 17 and connecting a 
PrmanRender node to the Viewer caused Nuke to crash.

• BUG ID 31511 - Tracker: Holding Shift to create new tracking anchors did 
not display the + cursor correctly.

• BUG ID 31817 - ModelBuilder: It was not possible to change the opacity 
of the highlight when in Face selection mode.

• BUG ID 32118 - Card3D: FrameHold and TimeOffset were ignored when 
motionblur was enabled.

• BUG ID 32132 - FrameHold was using the geometry cache incorrectly, 
causing problems with 3D preview rendering and motion vector 
calculation in some situations.
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Developer Notes 
• BUG ID 32134 - Tracker: Adding multiple tracking anchors and then 
translating the last anchor moved all anchors simultaneously.

• BUG ID 32250 - RotoPaint: After selecting a color from the color picker 
and painting a stroke, the color picker was hidden.

• BUG ID 32471 - TimeOffset nodes occasionally updated the Viewer when 
disabled in the Node Graph.

• BUG ID 32506 - Tracker: Duplicating a track and an expression linked 
transform didn’t work as expected.

• BUG ID 32558 - Tracker: The default track range was always +/-1 frame 
when using the forward or backward auto-tracking method.

• BUG ID 32600 - Tracker: Using keyframe tracking on patterns of 
different sizes did not interpolate the offset correctly.

• BUG ID 32682 - OCIO: The iff configuration was not included in the 
Project Settings > OCIO > OCIO config dropdown.

• BUG ID 32787 - Increasing the polygon count of a 3D object and setting 
a connected Normals node to action > build and attrib name > Cf or vel 
caused Nuke to crash.

• BUG ID 33076 - The ZDefocus and Convolve nodes didn’t work in the 
Nuke Personal Learning Edition (PLE).

• BUG ID 33147 - The Nuke User Guide referred to the preferences6.nk file 
rather than preferences7.nk file.

• BUG ID 33152 - Windows only: Right-clicking multiple selections in the 
RotoPaint curves list deselected everything other than the item under the 
mouse pointer.

• BUG ID 33261 - Mac OS X only: with a license that expires in less than 
30 days, double-clicking on an existing .nk script to open it caused Nuke 
to crash on launch.

• BUG ID 33264 - The Preferences > Path Remaps matrix did not handle 
back slashes correctly.

• BUG ID 33434 - When saving a Nuke script, roto shape points were 
sometimes offset from their original positions.

Developer Notes Here are the changes relevant to developers.

NOTE: See Help > Documentation > C++ Plug-in Development > NDK 
Developers Guide > Appendix C from the Nuke menu bar for more 
information.
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Developer Notes 
New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 33074 - A certain series of customer Python commands caused 
Nuke to crash.
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RELEASE NOTES FOR NUKE 7.0v2

Release Date  13 December 2012

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) and 10.7 “Lion” (64-bit)

• Windows XP Professional x64 Edition or Windows 7 Home Premium x64

• Linux RHEL 5.4 for Intel64 or AMD64

Note Mac OS X 10.8 “Mountain Lion” is currently not supported as an operating 
system for Nuke.

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

Note The compute capability is a property of the GPU hardware and can't be 
altered by a software update.

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, these are the normal graphics drivers for your 
NVIDIA GPU:

• Windows 275.36 (released June 2011) or later

• Linux 270.41.19 (released May 2011) or later

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 are as follows:

• Mac OS X 256.02 (released June 2011) or later

New Features There are no new features in this release. For a list of features new to  
Nuke 7, see Release Notes for Nuke 7.0v1.

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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Feature Enhancements 
Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes • BUG ID 26564 - GPU Acceleration: The Properties panel Local GPU text 
was misleading when Nuke was not launched as NukeX.

• BUG ID 32512 - Kronos: Frames past the ends of the input sequence 
were always held, even when the Read node was set to bounce, loop, or 
black.

• BUG ID 32744 - GPU-accelerated nodes, such as Denoise or Kronos, 
caused Nuke to become unresponsive in certain cases if there was 
another GPU-accelerated node further up the node tree.

• BUG ID 32788 - ZDefocus: Setting filter type to bladed offset the input 
image by -0.5 pixels on the xy axes.

• BUG ID 32823 - Convolve: Processing on some GPUs with large filter 
images connected caused Nuke to become unresponsive.

Developer Notes Here are the changes relevant to developers.

New Features There are no new features in this release.

Feature 
Enhancements

There are no feature enhancements in this release.

Bug Fixes There are no bug fixes in this release.

NOTE: See Help > Documentation > C++ Plug-in Development > NDK 
Developers Guide > Appendix C from the Nuke menu bar for more 
information.
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Release Date  29 November 2012

Supported 
Operating 
Systems

• Mac OS X 10.6 “Snow Leopard” (64-bit) and 10.7 “Lion” (64-bit)

• Windows XP Professional x64 Edition or Windows 7 Home Premium x64

• Linux RHEL 5.4 for Intel64 or AMD64

Note Mac OS X 10.8 “Mountain Lion” is currently not supported as an operating 
system for Nuke.

Requirements for 
NukeX GPU 
Acceleration

To take advantage of GPU acceleration, you need to have:

• A NukeX license.

• An NVIDIA GPU with compute capability 1.1 or above. A list of the 
compute capabilities of NVIDIA GPUs is available at:  
www.nvidia.co.uk/object/cuda_gpus_uk.html

Note The compute capability is a property of the GPU hardware and can't be 
altered by a software update.

• Graphics drivers capable of running CUDA 4.0 or above:

On Windows and Linux, these are the normal graphics drivers for your 
NVIDIA GPU.

On Mac, the CUDA driver is separate from the NVIDIA graphics driver 
and will need to be installed, if you don't have it already. Graphics drivers 
can be downloaded from www.nvidia.com/drivers and the minimum 
requirements for CUDA 4.0 on each OS are as follows:

• Windows 275.36 (released June 2011)

• Linux 270.41.19 (released May 2011)

• Mac 256.02 (released June 2011)

http://www.nvidia.co.uk/object/cuda_gpus_uk.html
http://www.nvidia.com/drivers
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New Features Alembic support

Nuke can now read and write Alembic (.abc) files (geometry, point clouds, 
cameras, and axes). See the Nuke User Guide, page 433, for more 
information.

DepthToPoints

The new DepthToPoints node, a gizmo containing DepthToPosition and 
PositionToPoints nodes, uses an image with a depth pass and a camera to 
produce a 3D point cloud. See the Nuke User Guide, page 433, and the Nuke 
Reference Guide, page 353, for more information.
DepthToPoints can be found in the 3D > Geometry menu.

DepthToPosition

A new DepthToPosition node has been implemented. DepthToPosition takes 
a depth pass and a camera and produces a 2D world position pass. See the 
Nuke User Guide, page 362, and the Nuke Reference Guide, page 354, for 
more information.
DepthToPosition can be found in the 3D menu.

ModelBuilder

The ModelBuilder node (NukeX only) provides an easy way to create simple 
3D models and add them to your image sequences in realistic positions. It 
uses a tracked camera and an input image for visual reference. You can also 
use other 3D geometry and point clouds as a reference if you already have 
these for your scene. See the Nuke User Guide, page 674, and the Nuke 
Reference Guide, page 378, for more information.
ModelBuilder can be found in the 3D > Geometry menu.

RAM caching

Nuke’s new playback caching feature retains frames in RAM memory rather 
than relying on the operating system's disk buffering system. Cached frames 
are highlighted with a green bar under the Viewer.

Relight

Relight is a new tool for lighting 2D footage based on position and normal 
passes. You can attach individual light nodes directly to the Relight node or 
use a Scene node to add multiple lights. See the Nuke User Guide, page 416, 
and the Nuke Reference Guide, page 417, for more information.
Relight can be found in the 3D > Lights menu.
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New Features 
TimeClip

The TimeClip node lets you move the clip forwards or backwards in time or 
reverse the order of frames in the clip. In addition to this basic 
functionality, you can fade from and to black, slip a clip in the Dope Sheet 
by dragging its head and tail to a new location, and includes the Read 
node’s hold, loop, and bounce frame range modes. See the Nuke User Guide, 
page 334, and the Nuke Reference Guide, page 103, for more information.
TimeClip can be found in the Time menu.

Tracker

Nuke’s 2D Tracker now includes a new Keyframe Tracking mode in addition 
to the Auto-tracking mode. You can track any number of features in a 
sequence, easily view a particular track or tracks using the Tracks list, and 
average the results of all tracks together. Other new features include:

• All tracking tools are now included in the Viewer toolbar, with associated 
hotkeys.

• Dynamic Viewer updates while tracking features, including a keyframe 
zoom window.

• Automatic export of tracks to CornerPin2D nodes.

• Automatic export of transform data to Transform nodes.

• Improvements to high frequency jitter removal.

• The ability to track more accurately through changes in brightness.

• Improved track error diagnostic and correction tools.

• Snap to markers assists Tracker by recognizing blobs or corner patterns 
in the sequence. You can enable Settings > snap to markers to assist you 
when placing anchors.

Whether you select blobs or corners, a guide displays in the Viewer as 
you drag the anchor, highlighting likely patterns.

See the Nuke User Guide, page 220, and the Nuke Reference Guide, page 
301, for more information.
Tracker can be found in the Transform menu.

Viewer improvements

• Nuke’s Viewer tools now include an icon  to disable all updates to 

the UI (except the Viewer) during playback. For example, when enabled, 
the Curve Editor, Dope Sheet, and RotoPaint controls are not updated 
frame by frame.

• Nuke Viewers now have guides, such as title safe, and mask overlays to 
help visualize different formats in the Viewer without reformatting. See 
the Nuke Getting Started Guide, page 101, for more information.
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Feature Enhancements 
Visual Studio Upgrade

Visual Studio on Windows has been updated from VS2005 to VS2010.

ZDefocus

ZDefocus is an upgrade to the ZBlur node, which now includes GPU 
acceleration, as well as an improved algorithm and some new features. 
Additionally, considerable effort has been put into improving its handling of 
edges and occluded areas compared to the previous ZBlur node. See the 
Nuke User Guide, page 292, and the Nuke Reference Guide, page 204, for 
more information.
ZDefocus can be found in the Filter menu.

Feature 
Enhancements

3D Viewer enhancements

• In the 3D Viewer, you can now create a Camera using the current view by 
navigating to Camera or Light look through > create camera.

• Nuke’s 3D Viewer now includes scale handles, similar to the rotate 
handles. To activate the scale handles, press Ctrl/Cmd+Shift and drag the 
handles in the Viewer.

CameraTracker

The existing workflow, Create Scene, has been split into Create Camera and 
Create Points, allowing you to control how you use CameraTracker more 
easily. See the Nuke User Guide, page 633, and the Nuke Reference Guide, 
page 326, for more information.

Convolve

Convolve now uses Fourier transforms to allow rapid convolutions of large 
plates. For even faster convolutions, you can now choose to process on the 
GPU. See the Nuke User Guide, page 289, and the Nuke Reference Guide, 
page 180, for more information.

DeepMerge

BUG ID 23020 - A new operation > holdout option has been added to 
DeepMerge nodes which outputs full deep data using the A input as the 
holdout over B. See the Nuke User Guide, page 451, and the Nuke Reference 
Guide, page 503, for more information.
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Feature Enhancements 
Denoise

The Denoise node, used to remove noise or grain from a shot, now includes 
GPU acceleration. See the Nuke User Guide, page 596, and the Nuke 
Reference Guide, page 184, for more information.

DepthGenerator

DepthGenerator has been improved to calculate cleaner, more accurate 
depth passes. The workflow has changed so that you can first analyze the 
shot to calculate the optimum frame separation. There are also new output 
options to convert depth to a position and normals pass for use with 
PositionToPoints or Relight as well as the option to create a displaced Card 
to match the Z-depth. See the Nuke User Guide, page 653, and the Nuke 
Reference Guide, page 349, for more information.

Displacement

Each Displacement node now has its own settings for tessellation rather 
than one global setting in the ScanlineRender node. See the Nuke User 
Guide, page 398, for more information.

FBX 2012

Nuke now supports FBX 2012 which adds support for version 7.2 .fbx files 
as well as being back-compatible with all previous versions.

FrameHold

FrameHold now supports geometry, cameras, lights and so on in the 3D 
Viewer. See the Nuke User Guide, page 338, and the Nuke Reference Guide, 
page 89, for more information.

Kronos

Previously F_Kronos, now features an improved algorithm and GPU 
acceleration. See the Nuke User Guide, page 606, and the Nuke Reference 
Guide, page 90, for more information.

MotionBlur

Previously known as F_MotionBlur, MotionBlur uses Kronos interpolation 
technology and features an improved algorithm and GPU acceleration. See 
the Nuke User Guide, page 613, and the Nuke Reference Guide, page 199, 
for more information.
MotionBlur can be found in the Filter menu.
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OpenEXR 2.0

Nuke can now read and write OpenEXR 2.0 images using DeepRead and 
DeepWrite nodes.

Particles

• ParticleEmitter now gives you greater control over the way particles are 
spawned:

• Emit from selection - emission is restricted to only selected elements 
of the upstream geometry (as indicated by a GeoSelect node).

• Emit from bbox - emission occurs from within the volume defined by 
the bounding box of an object. This can reduce the need for using the 
pre-roll option when creating volumetric particle simulations (BUG ID 
21104).

• Emit in randomized directions - a dropdown containing particle ran-
domization options has been added. This control defaults to No ran-
dom direction, simulating emission in Nuke 6.3v8.

• Transfer velocity and Transfer window - options to transfer any veloc-
ity that the initial emitter has to the particles. The Transfer window 
controls the time, in frames, to look forward and backward to deter-
mine the transferred velocity (BUG ID 22329).

• Particles can now be emitted from point clouds using any normals 
information present.

• BUG ID 22494 - The ParticleTurbulence node now includes offset 
modulation controls.

• BUG ID 31595 - Particles: The randomness controls in Nuke’s particle 
system have been improved to produce random spread at high frame 
ranges.

As a result, scripts created in Nuke 6.3 will no longer produce the same 
results when loaded in Nuke 7.

See the Nuke User Guide, page 699, and the Nuke Reference Guide, page 
493, for more information.

PointCloudGenerator

The PointCloudGenerator has been rewritten to calculate cleaner, more 
accurate point clouds. The workflow has changed so that you analyze a shot 
to set keyframes, calculating the accuracy for each keyframe. You can then 
select the most accurate frames to create a point cloud. Additionally, you 
can:

• Assign points to groups so that different parts of the scene can be 
labelled and visualized.
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• Bake out groups as a separate point cloud or mesh for use outside the 
PointCloudGenerator.

• BUG ID 16149 - PointCloudGenerator: Clicking Analyze Sequence now 
displays a warning if keyframes have already been calculated.

See the Nuke User Guide, page 663, and the Nuke Reference Guide, page 
392, for more information.

PositionToPoints (ImageTo3D)

PositionToPoints has been improved, including the ability to use geometry 
modifiers to alter the point cloud and being able to choose the points and 
normals channels to use from one input, rather than having to pipe in two 
inputs. See the Nuke User Guide, page 364, and the Nuke Reference Guide, 
page 397, for more information.

Primatte

Primatte has been upgraded to version 5, bringing with it numerous 
improvements and new features, including:

• Improved Auto Compute

• Smart Background Color Select, producing a better initial key

• Hybrid Render for creating a better key with foreground objects 
containing a similar color to the background color

• Adjusted Lighting for smoothing out the background screen color for 
better key color selection

• Several new output modes, most notably adjusted lighting outputs for 
using with other keyers

See the Nuke User Guide, page 91, and the Nuke Reference Guide, page 
223, for more information.

PrmanRender

The Shader tab in PrmanRender’s Properties now includes new motion 
vector options for storing distance and velocity in the motion channels.

Nuke 7 supports PRMan 15.2 and 16.4, and though other versions may 
work, using a version of PRMan other than these may produce unexpected 
behavior.

See the Nuke User Guide, page 720, and the Nuke Reference Guide, page 
399, for more information.
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Feature Enhancements 
R3D

Nuke has been updated to take advantage of the latest R3D SDK 4.3, which 
includes the following new features:

• REDcolor3 decode colorspace

• REDgamma3 gamma curve

• HDRx blending for RED Epic camera footage

Roto/RotoPaint

Nuke’s Roto and RotoPaint nodes have been completely overhauled, 
improving performance and the tools available.

• You can now split Roto controls and shapes in multi-view projects, 
allowing you to make edits to shapes on a per-view basis.

• The new stereo offset control allows you to move the selected stroke/
shape on the x and y axes. This is an extra transform that is applied after 
all other transforms. Typically, you would position the stroke/shape 
correctly in the hero view, then split stereo offset, and drag the stroke/
shape to its correct location in any other views.

• BUG ID 10332 - RotoPaint now uses a new format which has reduced 
script sizes significantly, when compared to previous versions of Nuke.

• BUG ID 11045 - Right-click copy/paste functions in the Viewer now 
display the number of curves or points selected. See the Nuke User Guide 
for more information.

• BUG ID 15854 - The right-click copy menu for points has been split into 
copy actions for curves and points, including the options to copy 
animation or single point values.

• BUG ID 18830 - The right-click menu in the curves list Life column now 
includes a frame range option, which displays a standard Set frame range 
popup.

• BUG ID 19248 - Playback in the Viewer has been improved when 
RotoPaint Properties panels are open.

• BUG ID 19313 - You can now paste copied splines into the Viewer after 
selecting a Roto/RotoPaint node in the Node Graph. If no nodes are 
selected, the spline is pasted to the last node that was selected.

• BUG ID 22197 - Roto: All Roto nodes now default to output > alpha.

Note This enhancement does not affect RotoPaint, which defaults to rgba.

See the Nuke User Guide, pages 164, and the Nuke Reference Guide, pages 
53 and 63, for more information.
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Roto conversion between Nuke 6 and Nuke 7

Nuke 6 scripts containing Roto display a conversion prompt when you open 
them in Nuke 7:

• Click Save As to convert the script to the Nuke 7 Roto format, or

• Click Ignore to load the Nuke 6 format into Nuke 7. You might select this 
option if:

• You don't intend to make any changes, or

• You want to overwrite the file with a Nuke 7 only Roto format when 
saving.

If you want Nuke 7 scripts to load in Nuke 6, use the convertToNuke6 or 
convertDirectoryToNuke6 Python functions when running Nuke 7 in 
terminal only mode:

Note The conversion functions cannot convert stereo-split curves as they are not 
supported by Nuke 6.

• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)

• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern 
=".*\.nk", overwrite = False)

Note The pattern is a regular expression.

An example single script conversion and rename to the same directory, from 
the command line (terminal):
$ <NukeInstallDir>/Nuke7.0v1 -t

>>> import nuke.rotopaint
>>> nuke.rotopaint.convertToNuke6("/tmp/myRoto7.nk", "/tmp/

myRoto6.nk")

ScanlineRender

In previous versions when using Project3D in occlusion mode it was 
necessary to also enable raycasting in the ScanlineRender node. This is no 
longer necessary and the option has been removed. The ScanlineRender 
node also has a new option for stochastic samples on the MultiSample tab. 
You can use this option to speed up or preview 3D motion blur at the 
expense of a noisier image. Additionally, new shadow and motion vector 
modes have been added, and performance improved:

• Some 3D nodes, such as Light, now include clipped alpha and full alpha 
shadow modes that feed into ScanlineRender.

• A new option has been added to the Shader tab, motion vector > 
distance, used to calculate “curved” motion blur by storing the distance 
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between samples in the motion vector channels. Additionally, motion 
vector > accurate has been renamed velocity.

• BUG ID 19650 - Optimization work on the ScanlineRender node has 
significantly improved render times in certain situations.

See the Nuke User Guide, page 351 and 444, and the Nuke Reference Guide, 
page 417, for more information.

SplineWarp

• Roto conversion between Nuke 6 and Nuke 7 requires some preparation. 
See Roto conversion between Nuke 6 and Nuke 7 for more information.

Note Although the script converting shapes from Nuke 7 to Nuke 6 modifies the 
roto work correctly to the Nuke 6 format, unsupported Nuke 7 SplineWarp 
settings are not converted.

• Cookie-cutter and transform linked toggles have been added to the 
curves list:

• Cookie-cutter is primarily designed to overlay a morph of two images 
on top of a sequence by creating a “traveling mask” between closed 
cookie-cutter shapes.

• Transform linked uses expressions to link properties panel Transform 
keyframes between shapes in the curves list.

• BUG ID 15854 - The right-click copy menu for points has been split into 
copy actions for curves and points, including the options to copy 
animation or single point values.

• BUG ID 18370 - You can now create source and destination splines 
independently of each other, which can then be linked manually.

• BUG ID 18382 - You can now marquee coincident points, after selecting 
both the A and B curves in the curves list, and drag both points together. 
A Viewer overlay on the points indicates that they are coincident.

• BUG ID 18498 - You can now copy and paste a single point from a source 
curve to a destination curve, and vice-versa.

• BUG ID 18596/25183 - The bbox dropdown has been replaced by a crop 
to format checkbox.

Disabling this control means that the input image is not cropped. For 
example, scaling down produces warped pixels from outside the Viewer 
image, rather than black.

• BUG ID 19315 - You can now attach a Tracker to source and destination 
splines independently.

• BUG ID 20930 - SplineWarp now supports warping by layer or by pair. 
The layer warp affects all shapes within that layer, and the pair warp 
affects joined shapes.

• BUG ID 23809 - Pins are now labelled with the name from the curves list.
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• BUG ID 24385 - New Preferences have been added on the Viewers tab to 
stipple joined splines.

See the Nuke User Guide, page 261, and the Nuke Reference Guide, page 
293, for more information.

TimeOffset

TimeOffset now supports 3D node input. See the Nuke User Guide, page 
334, and the Nuke Reference Guide, page 105, for more information.

VectorGenerator

Previously F_VectorGenerator, now features an improved algorithm and GPU 
acceleration. See the Nuke User Guide, page 603, and the Nuke Reference 
Guide, page 107, for more information.

Miscellaneous

• A new command line argument, -remap, has been added to take 
advantage of the new Path Remaps in the Preferences dialog, designed 
for cross-platform compatibility.

The -remap flag takes a comma-separated list of paths as an argument, 
arranged in pairs where the first path of each pair maps to the second 
path of each pair. For example, using:
nuke -t -remap "/mnt/netqa/, \\netqa\netqa\"

Converts any paths starting with /mnt/netqa/ (Mac OS X friendly) to start 
with \\netqa\netqa\ (Windows friendly).

• KeyMix has been added to the Reference Guide. See the Nuke Reference 
Guide, page 243, for more information.

• BUG ID 3914 - Project Settings > Views now includes a dropdown to 
select which view in a stereo project is the “Hero” view. See the Nuke 
User Guide, page 410, for more information.

• BUG ID 10143 - ReadGeo nodes now have a frame range control, 
negating the need for other 3D nodes, such as Card and Sphere, to have 
the same control.

• BUG ID 12185 - Information in the Nuke documentation regarding node 
concatenation has been improved. See “How Your Nodes Concatenate” in 
the Nuke User Guide, page 245, for more information.

• BUG ID 13071/24972 - The FFmpeg and FreeType libraries have been 
updated to the latest versions. See the Developer Notes for more 
information.

• BUG ID 14027 - When reading and writing .exr files, Nuke’s Read and 
Write nodes now include a do not attach prefix option to omit certain 
information in the metadata:
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Bug Fixes 
• Read - when enabled, the exr prefix is omitted from the metadata.

• Write - when enabled, the nuke prefix is omitted from the metadata.

• BUG ID 14217 - A new command line argument, --safe, has been added. 
Running Nuke in this mode stops the following loading at startup:

• Any scripts or plug-ins in ~/.nuke

• Any scripts or plug-ins in $NUKE_PATH or %NUKE_PATH%

• Any OFX plug-in (including FurnaceCore)

• BUG ID 16730 - Dope Sheet: Copy/pasting in the DopeSheet now pastes 
keys on the selected parameter starting at the current playhead location.

• BUG ID 17497 - You can now save the current pan/zoom level and jump 
to nodes, including Backdrop nodes, using the Quick Save and Bookmark 
functions.

• To save the current pan/zoom level, navigate to Edit > Bookmark > 
Quick Save1.

• To bookmark the current node, open the node’s Properties panel and 
enable Node > bookmark. Jump to a bookmark by navigating to Edit > 
Jump to Bookmark.

Note The bookmark control is enabled by default for Backdrop nodes.

• BUG ID 19243 - Roto, RotoPaint, and SplineWarp points are now drawn 
in a specified color, red by default, when they are expression linked. You 
can change the color in the Preferences dialog Viewers tab under Splines 
> general > Expression color.

• BUG ID 20208 - PlanarTracker: Creating a CornerPin2d (relative) now 
links to the PlanarTracker using the CornerPin2D > to knobs, rather than 
the Roto node’s extra matrix. This is consistent with the other modes and 
the Properties panel export, and enables the use of motion blur.

• BUG ID 22587 - DeepColorCorrect now includes a channels dropdown.

• BUG ID 24764 - The Nuke NDK documentation in Help > Documents > 
C++ Plug-in Development has been updated.

• BUG ID 26482 - Windows only: Instruction on how to install Nuke silently 
to a custom directory has been added to the Getting Started Guide.

Bug Fixes • BUG ID 1985 - GridWarp: Intermittent render artifacts appeared while 
warping in the Viewer.

• BUG ID 2642 - CurveTool: The ROI bounds reset to the format size after 
clicking Go! or connecting a Viewer in the Node Graph.

• BUG ID 4725 - It was not possible to copy animation data to GridWarp, 
SplineWarp, or Roto/RotoPaint controls.
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Bug Fixes 
• BUG ID 6216 - Using the Fit hotkey (F) in the Viewer with a ReadGeo 
node selected, or its Properties panel open, did not resize the Viewer 
correctly.

• BUG ID 6362 - Dot nodes in Groups with 3D or Deep nodes became 
disconnected during copy/paste operations in the Node Graph.

• BUG ID 7369 - Rendering multiple QuickTimes simultaneously was 
causing Nuke to crash.

• BUG ID 7743 - CurveTool: The ROI bounds reset to the format size when 
the preceding node in the Node Graph was disconnected.

• BUG ID 7856 - Opening the Properties panels for certain nodes was 
causing a customer script to slow down considerably.

• BUG ID 8430 - RotoPaint: It was not possible to split controls in multi-
view projects.

• BUG ID 8532 - File Browser: The Preview window attempted to process a 
view of gizmos and .obj files.

• BUG ID 8604 - Transform handles appeared in the 3D Viewer when 
selectable was disabled in the Properties panel of 3D nodes.

• BUG ID 9400 - Read nodes occasionally displayed no plugin named 
aviReader when FFmpeg failed to read a file.

• BUG ID 9672 - Nuke could not read .m4v files by default.

• BUG ID 9821 - Switching the Viewer channels dropdown to depth was 
causing Nuke to crash when CameraTracker or DepthGenerator nodes 
were present in a customer script.

• BUG ID 9934 - RotoPaint: Duplicate and paste operations did not shift 
selection to the new point or shape.

• BUG ID 9937 - Using File > Clear or calling nuke.scriptClear() in the Script 
Editor and then creating nodes did not read the default formats file 
correctly.

• BUG ID 10266 - The EdgeDetect node’s controls were ordered incorrectly 
and the tooltips were vague.

• BUG ID 10460 - The Glow node did not affect the alpha channel when the 
channels control was set to rgba.

• BUG ID 10586 - A customer script containing multiple RotoPaint nodes 
was experiencing severe slowdown.

• BUG ID 10647 - Setting Timeline range > Input in Viewer 2D mode and 
then switching to 3D did not persist the frame range.

• BUG ID 10986 - Two new metadata keys have been added for .exr files:

• exr/tiled - set to True in the metadata if the .exr is tiled.

• exr/compression - displays the compression type, either by name or as 
an integer. Refer to the Nuke User Guide, Appendix B for more infor-
mation.
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Bug Fixes 
• BUG ID 11045 - RotoPaint: The right-click menu copy > single point link 
option was not disabled when multiple points were selected.

• BUG ID 11466 - RotoPaint: The Viewer was slow to update when drawing 
strokes in a script containing 300+ strokes.

• BUG ID 11615 - Nuke’s Particle system, DisplaceGeo, PositionToPoints, 
and DeepToPoints nodes did not display progress bars and could not be 
cancelled once initiated.

• BUG ID 11622 - Rendering PositionToPoints through ScanlineRender was 
unaffected by lights in the scene.

• BUG ID 12577 - RotoPaint: Running certain customer Nuke scripts from 
the command line produced the following error, and caused the scripts to 
become corrupt after saving and loading:

AnimTree: Read Error, unknown token "Node:", expecting NumOfChildren:

• BUG ID 13110 - PositionToPoints point clouds were not affected by 3D 
geometry modifiers such as Trilinear, LogGeo, and DisplaceGeo.

Note DisplaceGeo nodes must be used in conjunction with a UVProject node to 
affect the point cloud.

• BUG ID 13150 - Roto/RotoPaint: The format control was misleading. 
When a new input was connected, root.format was displayed suggesting 
that it was in use.

• BUG ID 13864 - RotoPaint: With multiple RotoPaint nodes open, 
selecting points in one node disabled editing points in the others.

• BUG ID 14027 - The ModifyMetadata node was adding unnecessary 
namespace information when written out.

• BUG ID 15069 - Nuke attempted to check out a nukex_r licence when  
-nukex was specified during a command line only render.

• BUG ID 15164 - RotoPaint: The initial drag of the Transform > scale 
slider split the control into w and h controls.

• BUG ID 15267 - Editing the Read filepath in scripts containing both 
ScanlineRender and PositionToPoints nodes caused Nuke to crash.

• BUG ID 15399 - ScanlineRender included non-visible geometry when 
calculating shadow casting.

• BUG ID 15423 - PrmanRender: UVproject node output was not rendered 
correctly.

• BUG ID 15440 - ProjectionSolver: Locators added when the Viewer was 
set at a lower resolution to the source were not visible.

• BUG ID 15721 - Tracker did not handle footage containing high 
frequency jitter as well as expected.

• BUG ID 16120 - Nuke was retrieving incorrect frame ranges for 
QuickTimes when using FFmpeg.
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Bug Fixes 
• BUG ID 16350 - Read: Setting frame > start at and then changing the file 
location using the browser, resulted in an incorrect frame range.

• BUG ID 16849 - Adding keyframes in EXPTool nodes caused unexpected 
behavior in the Curve Editor.

• BUG ID 17059 - Roto/RotoPaint: Deleting strokes from a node containing 
multiple strokes was slow to recalculate.

• BUG ID 17083 - RotoPaint: Deleting an entry in the Properties panel 
curve list also removed the entry directly above.

• BUG ID 17107 - RotoPaint: Changing the color of a Checkerboard linked 
to a RotoPaint node caused Nuke to crash.

• BUG ID 17269 - Dope Sheet: New RotoPaint keyframes only appeared 
when mousing over the Dope Sheet.

• BUG ID 17436 - DeepRecolor didn’t normalize correctly when the alpha 
from a flat image didn't match up with deep opacity.

• BUG ID 17550 - The 3D Viewer did not always honor the display setting 
for geometry when you clicked on the Node Graph.

• BUG ID 17599 - RotoPaint: Moving keyframes in the Dope Sheet caused 
Nuke to become unresponsive.

• BUG ID 17774 - WriteGeo: The filepath in terminal output was incorrect 
from WriteGeo nodes.

• BUG ID 17990 - ModifyMetaData nodes crashed when trying to add 
string values from a Python pickle.dump() method.

• BUG ID 18015 - The filepaths to launch Nuke from the terminal were 
inconsistent in the documentation.

• BUG ID 18030 - PrmanRender: Importing .obj or .fbx files with no texture 
coordinates caused Nuke to crash.

• BUG ID 18044 - Emitting from edges or faces using the uniformly or in 
order options, still emitted particles from points.

• BUG ID 18115 - PlanarTracker: Enabling Tracking > Preview Features did 
not reliably display features in the Viewer.

• BUG ID 18132 - ReadGeo: Editing the Read path caused the node’s 
controls to reset to the default values.

• BUG ID 18203 - GridWarp: When persistent preview was active, the 
Viewer always showed rgb when channels was set to different sets.

• BUG ID 18257 - SplineWarp: Clicking on pins in the Viewer did not select 
them in the Properties curves list.

• BUG ID 18270 - SplineWarp: Expression linking Tracker transform values 
to control points produced incorrect translations.

• BUG ID 18271 - Windows only: The Error Console occasionally hung or 
crashed with certain node errors and had to be forcibly closed.
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Bug Fixes 
• BUG ID 18338 - LensDistortion: Entering RadialDistortion 1 or 
RadialDistortion 2 values outside the -0.3 to 0.3 and -0.1 to 0.1 range, 
respectively, caused Nuke to become unresponsive.

• BUG ID 18405 - SplineWarp: Smoothing or cusping a source curve also 
affected the destination curve if both were set to visible.

• BUG ID 18443 - Navigating to File > Close did not launch a new Nuke 
session after closing.

• BUG ID 18497 - SplineWarp: Right-clicking on a single control point in 
multiple selections only affected the single point.

• BUG ID 18542 - Linux only: Entering a value of 1e94 or higher in a 
Properties panel control caused Nuke to crash.

• BUG ID 18790 - It was not possible to read in geometry sequences using 
the R shortcut from the Node Graph. For example, myGeo.###.obj only 
read the first geometry object.

• BUG ID 19203 - SplineWarp: Hiding a shape in the curve list did not hide 
the associated correspondence curves.

• BUG ID 19205 - SplineWarp: Hiding a pin in the curve list did not hide 
that pin in the Viewer.

• BUG ID 19217 - Roto/RotoPaint: It was not possible to set a clone 
source for shapes in the curve list.

• BUG ID 19316 - Roto/RotoPaint: Nudging points using the numeric 
keypad did not nudge the transform bounding box accordingly.

• BUG ID 19354 - Particles: Motion vectors ignored the alpha channel.

• BUG ID 19423 - RotoPaint: The Properties panel was slow to open with 
500+ paint strokes in the Viewer.

• BUG ID 19855 - RotoPaint: The bounding box did not adjust 
appropriately when dynamic_size was enabled.

• BUG ID 19977 - ParticleBounce: Internal bounce occasionally leaked 
particles outside the limiting primitive when two ParticleBounce nodes 
were used simultaneously in a Particle system.

• BUG ID 20143 - Memory use was increasing consistently when rendering 
frames through ScanlineRender.

• BUG ID 20161 - Curve Editor: Scripts with high frame ranges, such as 
916925-917038, were slow to open in the Curve Editor.

• BUG ID 20243 - In stereo projects, right-clicking a node’s controls in the 
Properties panel and selecting Split all knobs was not reversible using Set 
knobs to default.

• BUG ID 20271 - Nodes containing text overlays did not display the text if 
they were registered as a Viewer Process in the Script Editor or menu.py 
file.

• BUG ID 20288 - Particle systems were re-evaluating from the first frame 
if the particle input was changed.
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Bug Fixes 
• BUG ID 20407- Changing the file name in a ReadGeo node did not update 
in the Viewer.

• BUG ID 20422 - LensDistortion: The Analyze Grid function was not 
computed when running Nuke in terminal (-t) mode. The correct syntax is:
./Nuke7.0v1 -t --nukex -i

• BUG ID 20548 - Mac OS X Lion only: Running Nuke from the terminal 
displayed a warning relating to Time Machine exclusion.

• BUG ID 20579 - ProjectionSolver: Attempting to undo add locator set the 
locator’s position to 0,0, rather than removing it.

• BUG ID 20582 - ProjectionSolver: After adding animation to a control, 
right-clicking in the Properties panel and then selecting No animation on 
all knobs removed all existing locators and added a new one at 0,0.

• BUG ID 20613 - The file browser occasionally reported incorrect file 
sizes when sequences and split sequences were enabled.

• BUG ID 20637/29613/29616 - Viewer performance was degraded when 
the Curve Editor/Dope Sheet was open.

• BUG ID 21237 - PrmanRender: The Viewer did not update when dof was 
enabled.

• BUG ID 21335 - Using a MergeMat node after a Project3D node overrode 
the disabled crop checkbox in the Project3D node.

• BUG ID 21438 - RotoPaint: Enabling motion blur for a shape and then 
fading the shape out using the opacity control, did not set the shape’s 
alpha value to 0.

• BUG ID 21494 - The Project Settings > Root > lock all connections 
option caused the Node Graph to be unreadable when zoomed-out.

• BUG ID 21708 - RotoPaint: Cutting a shape using Ctrl/Cmd+X was not 
undoable.

• BUG ID 21943 - Rendering a certain customer script from the command 
line caused Nuke to crash.

• BUG ID 22113 - ScanlineRender and PrmanRender motion blur sampling 
was inaccurate at low sample rates.

• BUG ID 22890 - The Viewer timeline showed a misleading frame range 
when an offset was applied in the Read node.

• BUG ID 23181 - Nuke’s exrReader did not handle case correctly when 
custom layer names were sorted alphabetically after the view name.

• BUG ID 23305 - Estimating anamorphic lens parameters was producing 
unusually large Squeeze and Distortion values.

• BUG ID 23393 - Enabling antialiasing in ScanlineRender nodes was 
rendering dots and lines in the Viewer.

• BUG ID 23506 - SplineWarp: Undo did not work as expected, and the 
curve list didn't update correctly when deleting a spline using the Viewer 
right-click menu.
Nuke 7.0v9The Foundry



RELEASE NOTES FOR NUKE 7.0v1 57
Bug Fixes 
• BUG ID 23597 - RotoPaint: Selecting multiple brush stokes in the curve 
list and editing the lifetime type control, deselected all the strokes.

• BUG ID 23670 - ScanlineRender: A customer script produced jagged or 
ripped geometry when rendered.

• BUG ID 23675 - Expressions based on metadata were not written when 
running Nuke from the command line using the -X Write arguments.

• BUG ID 23710 - A customer .exr sequence rendered with black lines in 
the Viewer.

• BUG ID 23897 - ParticleEmitter: Simulations were always starting from 
frame 0 if no ParticleEmitter nodes were present in the script.

• BUG ID 24092 - Attempting to group (Ctrl/Cmd+G) a Write node during 
rendering caused Nuke to crash.

• BUG ID 24183 - WriteGeo: Converting .obj files to .fbx files did not 
preserve normals data.

• BUG ID 24262 - RotoPaint: Moving the Brush Tool over the Viewer 
caused severe lag.

• BUG ID 24415 - A custom Camera node attached to Project3D node 
caused Nuke to crash when certain Properties panel controls were not 
defined.

• BUG ID 24450 - Tracker: Linking a Roto shape to a track using the right-
click Link to > Tracker1 > translate as offset option did not undo cleanly. 
Each vertex had to be undone individually.

• BUG ID 24492 - RotoPaint: It was possible to create duplicate shape 
names in the curve list by copying and pasting between RotoPaint nodes.

• BUG ID 24573 - Mac OS X only: ReadGeo nodes reading in .obj files with 
no UV information flashed when mousing between the Viewer and the 
Node Graph.

• BUG ID 24617 - Disabling a LensDistortion node was turning off the 
Node Graph grid overlay.

• BUG ID 24641 - RotoPaint: Locked shapes in the curve list could be 
moved in the Viewer using Ctrl/Cmd+A and then dragging the shapes.

• BUG ID 24756 - PointCloudGenerator: Reloading a saved script 
recalculated the point cloud unnecessarily.

• BUG ID 24835 - File Browser: Split sequences were listed in reverse 
order.

• BUG ID 24837 - A NoOp node in a customer script caused Nuke to crash.

• BUG ID 24879 - OCIOCDLTransform: Changing the values in the cccid 
dialog did not update the saturation knob value.

• BUG ID 24932 - Specifying an invalid OCIO config file caused Nuke to 
crash on exit.
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Bug Fixes 
• BUG ID 24988 - RotoPaint: Copy/pasting a layer name from one 
RotoPaint node to another changed the layer name.

• BUG ID 25027 - Linux only: Reading in a customer .tif file caused the 
Read node and terminal to display ’ERROR: Read4: Sorry, can not handle 
RGB image with Color channels=-636’.

• BUG ID 25187 - Connecting a Viewer to a Defocus node, downstream of 
a 3D setup, caused Nuke to crash.

• BUG ID 25371 - Mac OS X and Windows only: An excessive number of 
NukeQuickTimeHelper-32 processes were started.

• BUG ID 25472 - Passing a 4K image through a FrameHold node produced 
clipped output.

• BUG ID 25730 - Basic Array_knobs did not write out as useful userknobs.

• BUG ID 25908 - Face selection did not work as expected on concave 
geometry.

• BUG ID 26339 - Reconcile3D: Enabling calculate output live did not 
produce consistent results.

• BUG ID 26520 - A customer script, containing LensDistortion and writing 
out .exr files with autocrop enabled, was causing Nuke to crash when run 
from the command line.

• BUG ID 26618 - Node renames were only applied to the left view in 
multi-view expression links.

• BUG ID 26698 - Roto: Opening the Properties panel did not switch to the 
Select All tool.

• BUG ID 26825 - Writing an .exr file that only had image data outside of 
the image window and autocrop enabled caused Nuke to crash.

• BUG ID 27289 - ParticleExpression: Reversing the if logic in an 
expression produced an unexpected result.

• BUG ID 27381 - Switching between Framecycler and custom flipbooks 
with ROI checked caused Nuke to crash.

• BUG ID 27628 - OCIO: OCIODisplay didn't update the Viewer correctly 
when switching the layer control between all and custom layers.

• BUG ID 27949 - Disabling a DeepFromImage node upstream of a 
DeepMerge node in a customer script caused Nuke to crash.

• BUG ID 28231 - ScanlineRender: Heavy geometry, such as a card with 
high level subdivision, was causing performance issues farther down the 
node tree.

• BUG ID 28348 - Enabling and disabling a ReadGeo node in a simple 3D 
system upstream of a VectorBlur node was causing Nuke to crash.

• BUG ID 28757 - Adding RotoPaint shapes to the Curve Editor and 
attempting to move points caused Nuke to crash.
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Bug Fixes 
• BUG ID 29167 - SplineWarp: It was difficult to scale multiple selections 
using the corner of the Transform box.

• BUG ID 29255 - SplineWarp: Moving individual points on a curve was 
occasionally problematic.

• BUG ID 29442 - SplineWarp: Transforming shapes using the controls in 
the Transform tab while the Viewer was rendering caused Nuke to crash.

• BUG ID 29446 - Setting the OCIO environment variable did not update 
the Viewer LUT list as expected.

• BUG ID 29513 - OCIO ColorSpace: Setting an in or out colorspace was 
reverted to the default when the playhead was moved to another frame.

• BUG ID 29670 - Rendering a customer script containing a depth channel 
to .exr format was causing Nuke to crash.

• BUG ID 29748 - The Getting Started Guide contained inaccuracies 
regarding node specific cache locally controls.

• BUG ID 30151 - Enabling Occlusion testing in the Viewer caused Nuke to 
become unresponsive.

• BUG ID 30438 - Certain user interface checkboxes did not appear to 
change state when clicked.

• BUG ID 30529 - Nuke could not read .mp4 files by default.

• BUG ID BUG ID 30584 - Tracker: When Preferences > aggressive caching 
was enabled and postage stamp was in static frame mode, panning or 
zooming the Viewer occasionally caused Nuke to crash.

• BUG ID 30563 - Denoise: Setting Profile > Automatic and enabling Use 
GPU if available occasionally caused Nuke to crash with some GPU 
configurations.

• BUG ID 30774 - DeepExpression: Identical expressions did not produce 
comparable results in the Expression and DeepExpression nodes.

• BUG ID 31389 - Windows only: The AJA Kona 3G Monitor Out card could 
not be initialized.

• BUG ID 31555 - Color sampling in the Viewer when using a non-default 
LUT for 8-bit conversion of images containing a NaN (not a number), 
caused Nuke to become unresponsive.

• BUG ID 31559 - Deep: Color channel blending was incorrect for 
overlapping deep samples generated from within Nuke.

• BUG ID 32006 - There was a logic error in ocionuke.cdl, causing an 
“UnboundLocalError” message.
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Developer Notes Here are the changes relevant to developers.

New Features • BUG ID 10314 - You can now return coordinate information from a 
camera using the getGLCameraMatrix() method.

• BUG ID 20931 - You can now query whether a frame is cached or not 
using the frameCached() method. For example:

v=nuke.activeViewer().node()
isCached=v.frameCached(int frame)
print isCached

Which returns (True) or (False).

Feature 
Enhancements

• Most OS X third party libraries have been rebuilt against the 10.6 (Snow 
Leopard) SDK, as Nuke 7 does not support 10.5 (Leopard). The full list of 
library versions is as follows:

NOTE: See Help > Documentation > C++ Plug-in Development > NDK 
Developers Guide > Appendix C from the Nuke menu bar for more 
information.

Library Version

Alembic 1.0.5

Boost 1.46.0

DirectX Jun10 (Windows only)

FBX 2012

FFmpeg (git 2012-02-07)

FreeType 2.4.4

GLEW 1.5.8

Intel MKL Windows: 10.0.2.019

Mac OS X: 10.2.5.088

Linux: 10.1.1.019

Libpng 1.4.8

Libtiff 3.9.4

OpenColorIO 1.0.0

OpenEXR 1.6.1 (cvs 2008-03-03)

OpenEXR Deep Ops 2.0.0
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• BUG ID 11972 - RotoPaint: A new method, getSelected(), has been added 
to return the currently selected strokes and shapes.

• BUG ID 13026 - RotoPaint: You can now copy shapes to a new layer 
using Python.

• BUG ID 23866 - Using node.setName() to change a node's name broke 
any expressions referencing the node. 

A new function, updateExpressions, has been added to the setName() 
function to fix this issue.

Bug Fixes C++ specific bugs

• BUG ID 23330 - Using C++ Op_knob() in NDK plug-ins produced errors 
when used with internal knobs.

Python specific bugs

• BUG ID 8061 - The Pulldown_Knob.setValues() method did not include 
any way of sorting entries.

• BUG ID 11615 - The nodes listed below were calculating the image on the 
main thread causing a block:

• DeepToPoints

• DisplaceGeo

• Particle*

• PositionToPoints

These calculations still take place on the main thread, but before  
validate() in such a way that it can call progress functions and pump the 
event queue.

• BUG ID 13546 - The setVisible() call was not applied at group level when 
creating gizmos.

• BUG ID 14458 - Adding incorrect knob values, such as names containing 
incorrect case, to another node was causing Nuke to crash.

Primatte 5

PySide 1.0.9

Python 2.6.5

Qt 4.7.2

Truelight 3.0.4965

zlib 1.2.5

Library Version
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• BUG ID 20359/20479 - It was not possible to re-add a custom knob to a 
node once it was removed.

• BUG ID 22516 - It was possible to copy to the clipboard in command line 
mode using nuke.nodeCopy(). This should only be possible in GUI mode.

• BUG ID 23842 - The filenameFilter example in the Nuke Python 
Developers Guide contained inaccuracies.

• BUG ID 23866 - Using node.setName() to change a node's name broke 
any expressions referencing the node.

• BUG ID 25165 - Nuke was not releasing memory when custom QWidget 
panels were closed.

• BUG ID 26471 - Closing Nuke with a QDialog open caused a 
segmentation fault.

• BUG ID 27935 - The nuke.OutputContext.setFrame() method threw a 
ValueError exception when a negative float value was passed as an 
argument.

• BUG ID 29696 - The max_usage argument was incorrectly defined in the 
Script Editor help.

• BUG ID 32112 - Nuke’s Python contained naming inconsistencies 
between PyCustom_Knob and its class name, PythonCustomKnob.
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